Contents

1. Copyright Notice ................................................................................................................................. 3

2. Introduction ........................................................................................................................................ 5
   2.1 About Studio ............................................................................................................................... 5
   2.2 What is Studio Toolkit for Shrink Sleeves ................................................................................ 6

3. About Shrink Sleeves and Multipacks ............................................................................................... 7
   3.1 Shrink Sleeves ........................................................................................................................... 7
   3.2 Application examples of Shrink Sleeves ................................................................................... 8
   3.3 Distortion and predistortion ....................................................................................................... 9

4. 3D workflow for Shrink Sleeve Package ........................................................................................... 10
   4.1 Step 1: Set up the shape to be wrapped .................................................................................... 11
   4.2 Step 2: Create a Shrink Sleeve Structure .................................................................................. 11
       4.2.1 Add a sleeve ....................................................................................................................... 12
       4.2.2 Adjust the sleeve ............................................................................................................... 12
       4.2.3 Simulate the Shrink Process ............................................................................................. 14
   4.3 Step 3: Apply artwork ............................................................................................................... 14
   4.4 Step 4: Artwork Predistortion ................................................................................................... 15
       4.4.1 Predistort .......................................................................................................................... 16
       4.4.2 Working with predistorted art ......................................................................................... 22
   4.5 Step 5: Create 3D Visuals .......................................................................................................... 23

5. Using the Studio Toolkit application ................................................................................................ 24
   5.1 Saving and opening Collada files ............................................................................................... 25
   5.2 Import Into .................................................................................................................................. 25
       5.2.1 Obtain a 3D file for a container ....................................................................................... 25
       5.2.2 Using graphic files ............................................................................................................ 26
   5.3 Change the Camera viewpoint ...................................................................................................... 27
   5.4 Transform the selected 3D shape(s) ............................................................................................ 27
   5.5 Repeat ......................................................................................................................................... 32
   5.6 Selecting objects .......................................................................................................................... 33
   5.7 Tabs ............................................................................................................................................. 34
   5.8 Measurements ............................................................................................................................... 34
       5.8.1 Adding measurements ....................................................................................................... 34
       5.8.2 Setting up measurements .................................................................................................. 35
       5.8.3 Slant measurements ........................................................................................................... 36
   5.9 Preferences ................................................................................................................................... 37
1. Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries. Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office. Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007. All other product names are trademarks or registered trademarks of their respective owners. Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. Introduction

2.1 About Studio

Studio is a unique set of tools for 3D packaging design made specifically for packaging artwork professionals.

Working in 3D for packaging typically consists of 3 steps: first you create a shape or "structure". Next you apply artwork to that shape. And finally you present the result as an image, movie, etc.

To achieve this, Studio has different modules (shown as purple rectangles in the image underneath). It takes you through different software applications, such as Adobe Illustrator and the Studio Toolkit.

---

**Step 1: Create a Structure**

The first step is to prepare a 3D packaging shape, with a matching 2D key line template. This shape can come from one of the Studio Toolkits, from ArtiosCAD or from Esko’s Shape server.

The **Studio Toolkits** allow to create or modify structural design files for a specific use or workflow. Every Studio Toolkit consists of an Adobe Illustrator plugin and/or specific functionality inside the **Studio Toolkit** application. The Studio Toolkit application allows to import, create, modify or combine shapes, and save the result as a collada file.

- With the **Studio Toolkit for Boxes** plugin you can clean up die-drawings of boxes, and fold them into a 3D shape.

- You can use the **Studio Toolkit for Flexibles** functions in the Studio Toolkit application to create 3D models of flexible packaging.
• With the **Studio Toolkit for Labels** plugin, you can create round objects with one or more labels, and automatically warp artwork for conical labels. With the Studio Toolkit for Labels functions in the Studio Toolkit applications, you can draw labels on existing shapes.

• With **Studio Toolkit for Shrink Sleeves** in the Studio Toolkit application you can create a heat shrink sleeve around one or more shapes, and simulate the distortion. Using the Studio Toolkit for Shrink Sleeves plugin, you can apply counter distortion to your artwork.

**Step 2: Apply Artwork**

The second step is to make sure the production artwork fits to the structure.

In Adobe Illustrator, ArtPro or PackEdge, you can use **Studio Designer** to get a preview of the 3D object with its artwork, check every detail, and fix specific issues.

With **Studio Visualizer** you can simulate print substrates and a wide range of print and finishing effects.

**Step 3: Share**

You can share your 3D design using the Studio Viewer or Webcenter, or use your 3D design in Store Visualizer.

In Studio Designer and Visualizer, you can export your 3D designs to share realistic virtual packaging mock-ups as movies, images or interactive 3D.

### 2.2 What is Studio Toolkit for Shrink Sleeves

Studio Toolkit for Shrink Sleeves consists of two parts: the Shrink Sleeve functionality in the **Studio Toolkit** application, and the Studio Toolkit for Shrink Sleeves Illustrator plug-in.

**Studio Toolkit** is an application that contains functionality to easily and with precision wrap a shrink sleeve around one or more 3D objects. Using the Illustrator plug-in you can predistort artwork, to compensate for the deformation that will occur during the shrink process.

Studio Toolkit for Shrink Sleeves is a component of Studio, Esko’s solution for 3D packaging design.

This manual will also refer to other Studio components:

• Studio Designer

• Studio Toolkit for Labels

• Studio Visualizer

This manual assumes that you have these components installed too. Together, these components will help you design or adapt your artwork for your Shrink sleeve packages and produce good looking 3D visuals to communicate to your client.
3. About Shrink Sleeves and Multipacks

Examples of shrink sleeves:

3.1 Shrink Sleeves

Shrink sleeve labels are amongst the most advanced and versatile form of labeling the world over.
First of all, the shrink sleeve labels will be flat printed. Then the labels will be wrapped (seamed) onto the tube form and heated to adapt to the shape. This last step will distort the artwork that was printed on the label.

Shrink sleeves are usable for all kinds of packing. They can enhance the appearance and increase the value of the packed products, and can also resist dampness, dust and can even be used to prevent tampering and counterfeiting. It is insured that this shrink sleeve labels are perfect to protect the quality of the products packed with it. Attractively decorated shrink labels can be applied to a wide variety of container shapes and substrates, including Glass, PET, Plastic Bottles, Composite cans, Tin cans etc.

3.2 Application examples of Shrink Sleeves

**Labels**

- Food Products: Mineral Water, Soft Drinks, Beverages, Liquors, Pickles, Jams, Jellies, Fruit Juices, Tea, Coffee, Spices, Ghee, Edible Oils, etc. in bottle/can/jars
- Cosmetics: Powder, Perfumes, Hair Oils, Shampoos etc. bottles.
- Pharmaceuticals: Liquid Bottles

On the market there are also roll-on-shrink-on sleeves (also known as ROSO-labels). These are different from shrink sleeve labels in the way that they are seamed and placed around the object. But these differences are not relevant for Studio Toolkit for Shrink Sleeves, so it works just as well for ROSO labels.

**Multipacks**

A multipack is a repetition of products wrapped with a sleeve label, for protection and of course visual effects. You can easily add your artwork to the shrink sleeved material around the multipack. With Esko’s Shrink Sleeve software you can make your multipack and add your artwork to your 3D file. Below is an example of a Shrink Sleeve multipack:
3.3 Distortion and predistortion

When a flat printed label is heated to fit to the shape of the container, the artwork printed on the label will be distorted.

Often this distortion is an unwanted effect. Because of this, certain artwork elements might be moved to other parts of the sleeve. It is possible to compensate the artwork for the distortion. This is called pre-distortion.

When pre-distorting artwork, you often have to make compromises:

- Artwork just looks different on a curved surface. The appearance can also depend on the viewing angle.

- Due to the shrinking the area of the sleeve is reduced. So there is less room for artwork. It is possible that the original artwork design didn’t take this into account.

With Studio Toolkit for Shrink Sleeves you can adjust selected objects in your artwork with a single click. In some cases, some compromises and decisions have to be made. It is good practice to divide your artwork into separate parts and predistort these one by one.

How to apply predistortion is explained in Step 4: Artwork Predistortion on page 15.
4. 3D workflow for Shrink Sleeve Package

The illustration above shows the Shrink Sleeve workflow:

1. First you need to set up the 3D shape of the object(s) that will be shrink wrapped. See Step 1: Set up the shape to be wrapped on page 11

2. Next you create a 3D file that represents your shrink sleeve (at this stage without the artwork) in the Studio Toolkit application. See Step 2: Create a Shrink Sleeve Structure on page 11
3. You bring the file into Illustrator to create artwork, or adapt existing artwork to it. See Step 3: Apply artwork on page 14
4. If needed, pre-distort artwork to compensate for the distortion on the 3D shape. See Step 4: Artwork Predistortion on page 15
5. At any stage, you can output 3D visuals from Visualizer to communicate with your client. See Step 5: Create 3D Visuals on page 23

In the following chapters we will describe each of these steps in detail.

4.1 Step 1: Set up the shape to be wrapped

The purpose of this step is to set up the object(s) that will be wrapped in the Studio Toolkit application. See also Using the Studio Toolkit application on page 24

- You can import an existing 3D file, using the Import Into button. See Import Into on page 25

**Note:** If you select the imported shape, you can see its dimensions in the topright corner of the Studio Toolkit window. If the size is not correct, you have to fix this in the application that created the 3D file, and import the corrected file.

- You can import different 3D files and combine them, using the Move and Rotate tool. See Transform the selected 3D shape(s) on page 27

**Note:** You can also use the Move and Rotate tool to correct the shape if the imported object is not correctly oriented.

- You can repeat a 3D object, using the Repeat tool, e.g. to create a multipack sleeve. See Repeat on page 32

The shape to be wrapped can be one single object you import, or it can be a complex combination of shapes. For example, you can import the 3D file of a bottle, create a shrink sleeve around it, repeat the bottle and its sleeve 3 by 4 times, import a tray and put all bottles in the tray, and then create a sleeve around the tray and the bottles.

4.2 Step 2: Create a Shrink Sleeve Structure

The purpose of this step is to make a 3D file of the object(s) with a sleeve wrapped around them, so you can apply your graphics onto the sleeve. This 3D file can be repurposed for various artwork designs, as long as the internal shape and the sleeve parameters stay the same.

As input of this step, you need a 3D file of the object to be shrink wrapped. As output, you will have another 3D file (Collada file), with a printable part (the sleeve).

Collada files with a printable part can be used by Studio Designer or Studio Visualizer in the same fashion as an ArtiosCAD or Flexible Bag file.
The steps to create the Shrink Sleeve structure in Studio Toolkit are:

1. Add a sleeve on page 12
2. Adjust the sleeve on page 12
3. Simulate the Shrink Process on page 14
4. Save the Sleeve as a Collada file.

4.2.1 Add a sleeve

1. Make sure the object(s) you want to create a sleeve on, is selected.
2. Click the Add Sleeve button
3. Choose the orientation of the sleeve (X, Y or Z axis)

Most one-up shrink sleeves are vertical (the rightmost option), most multipack sleeves are horizontal

In the Sleeve view, you can see a 2D drawing of the sleeve. In the 3D View, you can see an unshrunk sleeve over the object(s). This sleeve can be adjusted in the next step, Adjust the sleeve on page 12

4.2.2 Adjust the sleeve
In the panel on the right side, you can change the dimensions of the sleeve. The descriptions below assume a vertical sleeve.

- **The Sheet size** can be set using the Circumference, the Cut Width or Lay-flat
  - The **Circumference** is the measured circumference of the tube after sealing. It does not include the overlap
  - The **Cut width** is the total width of the shrink film, including the overlap
  - The **Lay-flat** is the measured width of the shrink film when it is sealed and folded flat. This is half the Circumference.

By default, the Circumference is set to the size of the object + 10% extra space.

- **The Cut Length** is the height of the shrink sleeve.

  The default value is the total height for vertical sleeves, or the total width for horizontal sleeves.

- **The Positioning** can be set by aligning the ends of both the sleeve and the rigid shape / object, or by centering the sleeve on the object. The **Shift** allows to enter an offset.

  Typically, a sleeve is placed all the way down, since sleeve and object are both standing on a conveyer belt.

- **The Seam** allows to define the overlap size and direction. The seam is shown in the 3D view with a solid line and a dashed line.
• The Position of the seam can be set by entering a value, or by clicking and dragging the overlap in the 3D view.

Note:
For objects that are not round, it is important that you position the seam correctly on the object, the same as it will be in the actual production process, to get the correct structural design that would fit the graphics.

• Set the Material shrink characteristics. The first two values represent the maximum unconstrained shrink in machine direction and transverse direction. The Simulation slider allows to choose between more accurate or faster simulation. The Friction is the ratio of the force of friction and the force pressing the sleeve onto the surface. The higher the value of the friction coefficient the more difficult it will be for the sleeve to slide over the surface of the package in areas where there is tight contact.

Typical PET shrink film has a low shrink value in the machine direction, and a high value in transverse direction. This is represented in the default values (10% and 70%).

• Set the Preview
  a) Enable Wireframe to show the shrink sleeve as a frame of wires
  b) Disable Wireframe to show it as a Solid Colored sleeve.

4.2.3 Simulate the Shrink Process

If the sleeve has the right size, position and material settings, you can start the shrink simulation.

1. Click the Shrink button
   The application will start simulating the shrinking of the sleeve.
   At any time you can move and rotate the object by dragging it.
2. When you’re satisfied with the result, click the Done button

Attention:
The simulation does not stop by itself. Shrinking will continue until you click the Done button

The speed depends on the size and complexity of the enclosed object(s). For complex multipacks, the simulation can take up to an hour.

Note: After shrinking, you can no longer change the properties of the sleeve. You can however click the Restore Sleeve button (which will undo the shrinking), change the sleeve's properties, and redo the shrinking.

4.3 Step 3: Apply artwork

Now you have a collada file with a shrink sleeve around it and you need to apply artwork to it. You can do that in Illustrator with Studio Designer.
Note:
You can also use this 3D file in ArtPro or PackEdge. The possibility to pre-distort artwork is part of Toolkit for Shrink Sleeves and currently only available in Illustrator.

1. Open or place the collada file in Illustrator, just as you would with any other structural design file. For more info, we refer to the Structural Design manual.

2. Open the Studio window, by choosing \textbf{Window \textgreater{} Esko \textgreater{} Studio Designer \textgreater{} Show Studio Window}

You will now see your artwork in 3D.

4.4 Step 4: Artwork Predistortion

The \textit{Studio toolkit for Shrink sleeves} plugin for Illustrator offers a \textit{predistort} tool to predistort objects or groups of objects to compensate for the distortion on the 3D shape. Together with Studio Designer, the designers have a perfect 3D visual feedback to make sure the designs look good after shrinking as well.
See also *Distortion and predistortion* on page 9

### 4.4.1 Predistort

1. Choose **Window > Esko > Studio Toolkit for Shrink Sleeves > Show Predistortion** or use the shortcut **Alt Cmd 9** to open the Predistort window.

2. Select the artwork you want to distort.

   The Predistort window will calculate the average horizontal, vertical and sheared distortion of the selected artwork. These are average values, so the actual distortion may vary across the artwork.

   ![Predistort Window](image)

3. Click the **Predistort...** button to open the Predistort options.

   The Predistort options offer functionality to create a predistortion envelope that fits your design.
4. Choose the **Predistort Style**

Graphical designers want to map the 2D illustrator design onto a 3D curved surface, there is no single way to do this. Two different predistort methods (styles) are currently supported. See *Predistort Style 1* on page 18 and *Predistort Style 2* on page 19

5. Set the Viewing and Transform options. See *Viewing and Transform options* on page 20

6. Choose your mesh and the strength of the predistortion.

   While viewing the 3D preview, you can check if the distortion is not too much. You can for example only apply 85% of the distortion if this gives you the result you are looking for. The predistortion can only be decreased, so either 100% predistortion or less.

7. Click **OK**

---

**Note:**

The distortion is non-destructive, so you can still easily remove the distortion envelope, and text is still editable.

---

**Note:**

To apply the predistortion, Studio Toolkit for Shrink Sleeves creates Illustrator Envelope Distort objects. Adobe Illustrator has some limitation on Envelope Distort objects: you can not distort linked images. For this, you need to embed the images first.
Note:

You cannot create a sensible predistortion for all artwork in 1 go because the distortion values vary from spot to spot. It is best not to predistort the complete artwork, but work on selected objects or small groups of objects.

Predistort Style 1

When using Style 1, vertical edges look bended in frontal view but appear straight when looking at the edges from the side.
Predistort Style 2

When using Style 2, vertical edges look straight in frontal view but appear bended/skewed when looking at the edges from the side.
Viewing and Transform options

The **Viewing options** can be used to optimize the viewing angle. This will re-render the predistortion to fit the optimal viewing angle, i.e., if you know that the objects will be looked at mostly from a 10 degree angle, the graphics should be predistorted to fit that angle.

**Note:**

Optimize for Viewing Angle can only be used for Style 1 and not for Style 2.

The **Transform options** allow to tweak the design after predistortion. You can rotate or scale the selected object or group, or you can enter an offset, which will shift the object or group vertical or horizontal or both.
EskoArtwork

EskoArtwork
4.4.2 Working with predistorted art

- Select predistorted objects and click **Modify** in the Predistort window if you’re not quite satisfied with the result, to tweak the predistortion.

- If you moved predistorted objects to a new location, it is advised to click **Modify** as well, to update the predistortion grid to the new location.

- You can undo the predistortion by clicking the **Release** button.

  If you want to predistort the same object again, you will note that its previous predistort settings were preserved.

- If you open an Illustrator file or Normalized PDF file containing predistorted art, in a copy of Illustrator that doesn’t have the Studio Toolkit for Shrink Sleeves plugin, the predistorted art will be reinterpreted. The result is that the predistorted art remains visually unchanged, but you will no longer be able to modify the predistortion. A warning message will be shown:
4.5 Step 5: Create 3D Visuals

1. in Studio Designer you can opt to export to a 3D PDF file that can be sent to the customer, or to a hires TIFF pack shot which could be further enhanced in Adobe Photoshop. To do this, open Studio Designer and choose Export from the flyout menu.

2. If you first want to add some print finishes like embossing or foils, you can open the file in Studio Visualizer.
   a) Select **File > Open in Visualizer**
   b) Finalize your file, for example by adding an opaque white backing.
   c) From Studio Visualizer you can export files to different image formats, to quicktime movie format or to a collada file.
   
   For more information we refer to the Studio Visualizer documentation

You can also export a 3D PDF from Studio Designer. Choose **Export PDF file with 3D design** from Studio's export menu. As Studio Designer doesn't support transparency the material will be shown opaque. For example in the seam area only the artwork from the top part will be shown.
5. Using the Studio Toolkit application

The **Studio Toolkit** application is a standalone application allowing to import, edit and create 3D objects, and save the object(s) as Collada file.

1. The **Zoom** buttons, allowing to change the zoom factor of the preview window. You can also change the camera view point: see *Change the Camera viewpoint* on page 27
2. **Import Into** allows to import 3D or image files. See *Import Into* on page 25
3. The **New Bag** tool, used in Studio Toolkit for Flexibles
4. The **Add Sleeve** tool, used in Studio Toolkit for Shrink sleeves
5. The **Add Label** tool, used in Studio Toolkit for Labels
6. The **Transform** tool. See *Transform the selected 3D shape(s)* on page 27
7. The **Repeat** button. See *Repeat* on page 32
8. The **Settings** pannel, allowing to change or view the parameters on the selected object
9. the **Preview** panel
10. The different **Tabs**. See *Tabs* on page 34
11. When performing some specific functions (such as Transform, ...), a settings bar is added underneath the Toolbar.
5.1 Saving and opening Collada files

When saving a file from **Studio Toolkit**, the file is saved as a Collada file, containing the shape and all printable parts.

This means the file can be opened by any application that is capable of handling Collada files, such as Studio Designer.

However, the Collada files saved by Studio Toolkit also contains native Studio Toolkit information, allowing to reopen the file in Studio Toolkit, maintaining its editability, the active tab, zoom and view factor, etc.

**Note:** When dropping a Collada file onto the Studio Toolkit application, Studio Toolkit will determine if it is a Collada file saved in Studio Toolkit or not. A native Studio Toolkit Collada file will be opened, a regular Collada file will be imported.

5.2 Import Into

Using the **Import Into** button, you can import a 3D shape into your open scene. If you already have a 3D object in your scene, the newly imported 3D shape will be placed next to it.

For more info on how to obtain a 3D file, see **Obtain a 3D file for a container** on page 25

When importing a Collada file, any printable parts from this file will be preserved when saving to a Collada file.

**Note:** Collada files saved by Studio Toolkit can also be opened instead of imported. In that case, the file will be reopened as it was saved, with the same active tab, zoom and view, and maintaining full editability. See **Saving and opening Collada files** on page 25

You can also use the **Import Into** button to import an image (JPG or PNG) in a 2D tab (e.g. the "Sleeve" tab), to get a preview of this image on the corresponding 3D object. See **Using graphic files** on page 26

**Note:** Studio Toolkit can not import .bag files. If you need to compose flexible bags or boxes saved as .bag files, we suggest you convert these to Collada files in Studio Designer first.

5.2.1 Obtain a 3D file for a container

There are several ways to obtain a 3D file:

- You can get a shape on Esko's online Shapes store
• You could hire a 3D artist to make the shape with a 3D modeling tool, such as Cinema 4D, 3DS Max, Maya or Strata. If you are experienced with these tools, you could do it yourself.

• Contact the mold-designer and ask him for a Collada or OBJ file of the container.

• If you have a physical sample of the object, you can use a tabletop 3D laser scanner. See www.nextengine.com for an example of such a scanner. This device can output .obj files.

• If the object is a round shape, you can use Studio Toolkit for Labels to create it yourself. For more information, we refer to the Studio Toolkit for Labels documentation.

The format needs to be collada (.zae or .dae) or .obj. Collada stands for COLLABorative Design Activity for establishing an interchange file format for interactive 3D applications) These 3D files do not need a printable part at this stage, you will add that yourself in the next step.

5.2.2 Using graphic files

In Studio Toolkit you can import graphic files to get a preview of the result, and to assist in positioning e.g. the overlap. You can also use it to place a technical drawing on the sleeve.

Using the **Import Into** button you can import an RGB JPEG or PNG file.

• If a 2D tab is selected, the image will be imported in that tab

• If an object is selected in the 3D tab, the image will be imported in the corresponding 2D tab, and this 2D tab will become active

By default, the image will be aligned with the bottom left corner of the image on the bottom left corner of the printable part. You can move the graphic by clicking and dragging the border. The border (left, right, top or bottom) or corner you clicked, will become magnetic, and snap to the borders and folding lines of the 2D shape, allowing easy alignment.

This magnetism is shown using a thick blue line.

The 3D tab will show a 3D representation of the file with the corresponding graphics on it.
5.3 Change the Camera viewpoint

You can interactively change the camera view point

1. Click and drag to rotate the camera
2. Hold the **Shift** key and click and drag to move the camera viewpoint
3. If another tool is active, you can
   a) Hold the **Space** key, and click and drag to rotate the camera
   b) Hold the **Space** and **Shift** key and click and drag to move the camera viewpoint

5.4 Transform the selected 3D shape(s)

Since you are working in a 3D environment, you can move and rotate any object based on 3 axis. Imported Collada files and OBJ files can also be scaled.
If the Transform tool is selected, you can select one of four modes in the settings bar:

- Select **Simple Transform** or use its shortcut **T**
• Click and drag the center anchorpoint or change the Offset X and Z value to move the object over the X and Z axis. Holding down the shift while dragging will constrain the movement to either only along the X or Z axis.

• Click and drag the anchor point on the circle or change the Rotation value to rotate the object on the Y axis. Holding down the shift while dragging will constrain rotation to multiples of 45 degrees.

• Simple Move and Rotate keeps the object aligned with the floor. However, by setting the Distance from Floor option in the settings bar, you can also move the object over the Y axis.

Select [Move] or use its shortcut [M]

• Click and drag any of the anchorpoints or change the Offset X, Y or Z value to move the object over the X, Y and Z axis.

• Select [Rotate] or use its shortcut [R]
• Click and drag any of the anchorpoints or change the Rotate X, Y or Z value to rotate the object over the X, Y and Z axis. Holding down the shift while dragging will constrain rotation to multiples of 45 degrees.

**Note:** When moving or rotating a 3D shape, the depending parts (sleeves and labels) are moved / rotated along.

• Select **Scale** or use its shortcut **S**
• Click and drag one of the anchor points to change the size of the object, using the opposite anchor point as center of origin. If you hold down the Alt key, or if you adjust the values in the Scale width, height or depth field, the scaling is done from the 3D mid point of the object.

• By default, the Uniform option is selected, so the object is scaled uniformly in the 3 directions. Changing the value for Scale width, height or depth will change the two other values as well.

• By deselecting Uniform, you can scale the object in any direction. You can restrain the scaling to uniform by holding down the Shift key.

Note: Holding down the Shift key does not give the same result as selecting the Uniform option again: the first will only restrain the current transformation to Uniform, while reselecting Uniform will adjust the complete transformation of the object to a Uniform scaling.

The Scale tool is only available when an imported Collada file or OBJ file is selected. It is not available for Bag files, or for objects that already have a Sleeve or a Label attached in Studio Toolkit for Shrink Sleeves or Studio Toolkit for Labels.

The scale option performs a scale of the three dimensional shape of the selected object. The uniform scale is very useful to correct an object that has suffered from an incorrect unit-conversion from a 3rd party CAD system. The non-uniform scale can be powerful to fine-tune the dimensions of an imported product so that it fits into its packaging.

The scale option is not suitable for printable parts as their size affects other aspects such as the 2D drawing and the artwork mapping. A straightforward scale of a printable object in 3D would result in unwanted side-effects.
To change the size of printable objects, you should use other tools instead:

- To scale an object with a label or a shrink sleeve, first scale the container (without the label or sleeve) and then add the label or sleeve.
- To scale a flexible bag, modify its dimensions in the details panel.
- To scale a box, tray or carton, or a shape created in a third party application, go back to the application where you created it (Toolkit for Boxes, ArtiosCAD, the third party application used to create the shape).
- For Shapes models, you can order a new (scaled) variant via Esko’s 3D modeling service.

If you click and drag but not on any of the anchor points, you will change the camera position, but the object will NOT move or scale. This might be necessary to make all handles visible.

**Tip:** After rotating or scaling, you might need to align the object with the floor again. You can do so by switching to Simple Move and Rotate, and set the **Distance from floor** to zero.

### 5.5 Repeat

Using the **Repeat** button, you can create a simple repeat of the selected object(s).

- Enter the number of repeats you want along the X, Z and Y axis
- Enter a **Gap** value to add distance in between the objects
- Click **Done**
After the repeat, you will have multiple instances of a single object. This means making changes to one of the objects will also modify the others, while you can move and rotate the instances independently.

**Note:** If you have one instance selected, you can use **Edit > Select all copies** to select all instances.

### 5.6 Selecting objects

When you import or create objects in Studio Toolkit you also might need to select them. Go to the **Edit** menu to view the selection options.

There are several ways of selecting objects:

- Simply click on an object to select it.
- Hold **SHIFT** and click to select multiple objects.
- Use the **Cmd-A** (Mac) or **Control-A** (Windows) shortcut to select all the objects.
- "Select all copies" is only available when an object that is part of a repeat is selected. It will select the other instances of the repeat. Use the **Cmd+Option+A** (Mac) or **Control+Alt+A** (Windows) shortcut.
- "Invert Selection" will select all objects that are not part of the current selection.

- Simply click on an object to select it.
- Hold **Shift** and click to select multiple objects.
• Use the Cmd-A (Mac) or Control-A (Windows) shortcut to select all the objects.
• When an object that is part of a repeat is selected, you can use Select all copies to select the other instances of the repeat. You can also use the Cmd+Option+A (Mac) or Control+Alt+A (Windows) shortcut.

Tip: By holding the option (Mac) or alt (Windows) key and clicking on one object several times, you can select objects that are behind the selected object.

Note: Most selection options also work in 2D view.

5.7 Tabs

At the bottom of your Studio Toolkit window, you can see the different Tabs.
First is always the 3D tab. Next to that, a 2D tab is shown for every 2D object created in Studio Toolkit: a Sleeve, a Label, a Bag, ...
Deleting an object will also delete the corresponding 2D tab. Different instances (created using Repeat) share the same 2D tab. In that case the 2D tab will be deleted if the last instance of the object is removed.
You can rename any 2D tab by double clicking the name and entering the new name.

Note: The name entered for the 2D tab will be stored as the name for the technical drawing in the collada file, and will thus be used when importing the collada file e.g. in Studio Designer.

You can switch between the 3D tab and the 2D tab of the selected object, by choosing View > Go to 3D or View > Go to 2D, or by using its shortcut Cmd-G

5.8 Measurements

Using the Measurements tool in the 2D drawing of a bag, shrink sleeve or label, you can add essential measurements to the technical drawing.
The measurements you set up are automatically recalculated if you change the dimensions or other settings of a bag. In some cases, if the changes are too drastic, some measurements might be removed.
All measurements are saved inside the Studio Toolkit file and visible when placed in e.g. Adobe Illustrator. When placed in Adobe Illustrator, the measurements are placed in a separate sub-layer of the structural design file.

5.8.1 Adding measurements

To add new measurements:

1. Select the 2D tab in which you want to add measurements
2. Select the New Measurement tool.

A measurement is drawn between the points of line intersections. When the Measurement tool is activated those points are clearly visible and light up when nearly selected.

3. Click and drag from one intersection point to another to add the measurement to your document.

Note: When measuring slanted lines, you will see either the vertical or horizontal distance. See Slant measurements on page 36

5.8.2 Setting up measurements

You can change the way measurements are shown on your document.

1. Select the 2D tab in which you want to change the measurements.
2. Select the measurement(s) you want to modify.

Note: You don’t need to have the New Measurements tool active to select and modify a measurement.

The palette will show the settings of the selected measurement.
3. Make the changes you want

- click and drag the measurements to move them closer to or further away from the intersection points.
- for slant measurements, click and drag to rotate the measurement. See Slant measurements on page 36
- In the Measurement Text section, change the unit for the selected measurement, the number of decimals, and whether or not the units need to be shown.
- In the Text Style section you can set the text size in points. Note that the size of the arrow heads is changed accordingly.
- You can define if the text should always be horizontal, or according to the measure line. In the latter case, you can define if the text should be above, on or below the line. You can also set if the text should be positioned on the left / bottom, on the center or on the right / above.
- Click the Select All button to select all measurements at once. This allows to change the units, font size, ... for all measurements in one go.

5.8.3 Slant measurements

When measuring slant lines, or simply measuring between two points that are not on a vertical or horizontal line, the measurement will by default show either the vertical distance or the horizontal distance, whatever is the biggest value.
If you want to change what distance to show (either vertical, horizontal or slanted distance), you can do so by clicking and dragging the measurement to rotate it.

Below you see some different results for the same two intersection points.

5.9 Preferences

You can open the preferences by choosing **Studio Toolkit > Preferences...** (Mac) or **Edit > Preferences...** (Windows).

In the preferences, you can set the unit to be used for **Dimensions** (millimeter, centimeter or inch) and for **Volumes** (milliliter, centiliter or US fluid Ounce).